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1. INTRODUCERE 
 
Va multumim ca ati optat pentru serviciul Anyma Online Trading oferit de BRD Groupe 
Societe Generale.  

Descoperiti cea mai inovatoare si performanta platforma online pentru tranzactionarea pe 

Bursa de Valori Bucuresti si alte piete internationale: ANYMA Online Trading Platform. 

Utilizand acest serviciu beneficiati de siguranta maxima, BRD implementand in acest scop 
sisteme performante de securitate dar care in acelasi timp ofera si mobilitatea de care aveti 
nevoie.  

 
Utilizarea platformei este intuitiva, toate operatiunile se desfasoara in cativa pasi simpli, iar 
posibilitatile de personalizare sunt virtual nelimitate.  

 
Acest ghid detaliat va ajuta sa descoperiti cea mai mare parte din functionalitatile 
serviciului. 
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2. CONDITII DE UTILIZARE  
  
Aplicatia este disponibila pe orice echipament PC avand sistem de operare Windows (versiunile  
Vista, Windows 7, Windows 8, Windows 10) si poate fi descarcata si instalata gratuit de la 
adresa:   
https://www.brd.ro/_files/other/InstallInfront.exe   
 

Serviciul necesita acces la Internet, indiferent de modul de conectare (retea mobila, retea 
wireless).   
 
Dupa descarcarea fisierului executabil si lansarea acestuia (prin selectarea optiunii „Run”) va 
aparea urmatorul ecran:   
 

 
 

In ecranul de mai jos se va selecta Next : 
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Pentru a putea continua va trebui sa certificati ca sunteti de acord cu termenii si conditiile impuse 
de furnizorul Infront : 
 

 
 
In ecranul urmator se va selecta optiunea de instalare personalizata (Custom), in care puteti 
alege locatia de pe hard-disk pentru aplicatie sau optiunea implicita (Install Now) :  
 



   

ANYMA ONLINE TRADING / GHID DE UTILIZARE       Pagina  6 / 34 

 

 
Daca programul se va instala si nu vor aparea probleme in timpul instalarii, se va afisa mesajul: 

 

 
 

Acesta reprezinta semnalul ca programul a fost instalat si este gata de rulare. 

Prin apasarea iconitei  (shortcut-ul aplicatiei creat pe desktop) se va lansa aplicatia: 
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3. ACTIVAREA SERVICIULUI  

3.1. AUTENTIFICAREA STATICA  
  

 
La prima pornire a aplicatiei va trebui sa introduceti datele de conectare (user si parola) primite 
in email-ul de confirmare deschidere cont:  
 

  
 
 

Dupa introducerea acestor date, aplicatia este gata de utilizare pentru vizualizarea de cotatii, 
tranzactii si stiri.   
  
NOTA: In cazul in care accesul la internet se face printr-un server proxy, puteti seta programul 
sa foloseasca un astfel de server mergand pe tab-ul Proxy (din Advanced Setings). Datele de 
conectare la serverul proxy le puteti obtine de la furnizorul dumneavoastra de internet sau de la 
administratorul de retea.  
 

Autentificarea statica 
(user/parola primite prin e-mail) 
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Dupa introducerea  datelor de conectare (user si parola) este necesar sa inchideti aplicatia. La 
redeschidere, odata cu folosirea noilor date de conectare introduse, veti primi drepturile 
specifice conform contractului. Aplicatia retine datele de autentificare si la urmatoarea pornire 
nu le mai solicita.  
Schimbarea parolei statice se realizeaza din meniu sectiunea My Profile/Account/Change 
password, la final fiind necesar un restart al aplicatiei.  
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Aplicatia este disponibila si in limba romana. Initial se instaleaza in limba engleza.  
Schimbarea setarilor pentru limba se poate face in meniul Tools/Advanced Settings/User 

Interface/Regional. Dupa salvare si repornirea aplicatiei, ecranele se vor deschide cu meniurile in 
limba selectata. 
 

 
 

Va recomandam sa instalati si una din aplicatiile de antivirus disponibile pentru Windows PC, 
pentru protectia impotriva furtului de date, impotriva accesului neautorizat, etc.  
 

Userul si parola se pot modifica ulterior accesand sub-meniul Tools/Advanced Setings /Login  



   

ANYMA ONLINE TRADING / GHID DE UTILIZARE       Pagina  11 / 34 

 

 

  
 
 

3.2. ACTIVAREA FUNCTIONALITATILOR DE TRANZACTIONARE SI 

CONSULTAREA PORTOFOLIILOR   
Pentru activarea acestor functionalitati aveti nevoie de un dispozitiv de tip DIGIPASS.  
  
Daca ati optat pentru un dispozitiv de tip token DP 260 puteti sa nu luati in considerare 
pargaraful urmator.  
  
Daca ati optat pentru varianta software a acestui dispozitiv, va trebui sa urmati pasii de mai jos 
in functie de dispozitivul ales: Smartphone cu sistem de operare iOS, Android sau Windows 
Mobile (cel putin versiunea 7).  
  

Pas 1: Receptionarea elementelor de securitate din partea bancii:   
- Datele de identificare (Serial Number, Activation Code, Username) transmise prin email dupa 
semnarea contractului.   
- Codul de activare (Activation Code) transmis prin SMS direct pe telefonul mobil specificat in 
Cererea de Utilizare   
 
Pas 2: Descarcati gratuit aplicatia specifica telefonului sau tabletei pe care o utilizati. In functie 
de sistemul de operare utilizat de telefonul tau, aplicatia se descarca din:  
- Google Play Store pentru sistemul de operare Android – aplicatia BRD Anyma Digipass   
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- AppStore pentru sistemul de operare iOS - aplicatia BRD Anyma Digipass  
- Windows Store pentru sistemul de operare Windows Mobile – aplicatia BRD Anyma Digipass  
 
Pas 3: Instalati aplicatia   
Pas 4: Acceptati termenii si conditiile BRD  
Pas 5: Introduceti elementele de securitate: Serial Number, Activation Code, Username, Parola 
locala  
  
Codurile de securitate devin invalide daca sunt introduse gresit de 5 ori. In acest caz este 
necesar sa contactati Banca pentru a va fi atribuite noi elemente de securitate.  
  
Informatiile de pe device-ul mobil trebuie sa fie sincronizate cu serverul Digipass. Daca 
activarea esueaza contactati administratorii Anyma la adresa anyma@brd.ro sau telefon 021 
301 4336.  
  

NOTA: Un utilizator poate  opta pentru o singura varianta de dispozitiv DIGIPASS.  
 

 

4. ACCESAREA SI SECURITATEA SERVICIULUI  
  
Elementele de autentificare sunt confidentiale si trebuie sa fie cunoscute doar de 
dumneavoastra. Acestea nu trebuie comunicate verbal, prin telefon, prin e-mail sau formular 
niciunei alte persoane, chiar daca persoanele respective sunt reprezentanti BRD - Groupe 
Société Générale sau orice alta autoritate.   
  

Metoda principala de securitate pentru functionalitatile de tranzactionare si consultare 
portofolii este un token Vasco Digipass. Acesta este o solutie avansata de securizare a accesarii 
serviciului si a semnarii tranzactiilor. Simplu si avantajos, cu tokenul hardware sau mobil 
generati parole si semnati tranzactii direct in cadrul aplicatiei online trading.   
 
 
 
 
 
 
 
 
 
 

mailto:anyma@brd.ro
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5. UTILIZARE APLICATIE  

5.1. PAGINA DE START  
  
La prima deschidere a aplicatiei, dupa introducerea parolei statice primita pe email (vezi 
capitolul 3.1), vi se va prezenta fereastra standard (daca raspunsul la intrebarea daca doriti 
ecranul default este Da) concomitent cu o a doua si ultima autentificare, respectiv parola 
dinamica generata cu Digipas. Pentru folosirea  Digipass-ului vezi capitolul 7.  
 

 
 

5.2. PERSONALIZARE ECRANE COTATII  
 
Fereastra de cotaţii prezintă preţurile instrumentelor de pe piaţa configurată.   

La deschiderea unei ferestre de date, inclusiv la pornirea aplicaţiei, aceasta începe să descarce o 

imagine a pieţei.  

 
 

Autentificarea 
dinamica (Digipass 
mobile sau fizic) 
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Aplicaţia permite definirea mai multor ecrane (desktops) de informaţii prin efectuare unui Click-
dreapta pe numele ecranului din bara de jos şi alegerea opţiunii: Add Desktop.  Tot prin 
efectuarea unui click-dreapta pe numele ecranului se poate schimba numele acestuia sau se 
poate şterge: 
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Aranjarea ferestrelor in spatiul de lucru se poate face prin repozitionare si redimensionare in 
functie de preferinte.   
La sfarsit se salveaza modificarile workspace-ului apasand Ctrl+S (Save).  
 

 
 

  

Mutarea dintr-un ecran in altul se face apasand pe tab-ul cu numele ecranului din partea de jos 
a ecranului.  
Un ecran nou nu contine initial ferestre cu date. Pentru a afisa informatii este necesar sa 
deschideti din meniuri informatiile de care aveti nevoie.  
  
Veti gasi mai multe ecrane predefinite pe care le puteti incarca automat in sectiunea 
Meniu>Workspace>New Desktop (sectiunea Vendor):  
 

Salvarea setarilor se 
realizeaza prin Save (Ctrl+S) 
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5.3. FERESTRE APLICATIVE (COTATII DE PIATA, TRANZACTII,GRAFICE,STIRI) 
Odata pornita aplicatia, aceasta prezinta utilizatorului un ecran cu mai multe ferestre 
informative:  
- Cotatii  
- Grafice  
- Blotter   
 
Ferestre aditionale se pot deschide din meniul aplicatiei.  

 
 
 

5.3.1. COTATII DE PIATA   

  

Ferestrele de cotaţii se deschid din meniul Tools/Market, alegand pieţele de pe care doriţi să 
vedeţi cotaţiile: 
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Fereastra de cotatii reprezinta o lista de preturi ale instrumentelor de pe piata aleasa. 
 

Într-un ecran (desktop) pot fi deschise mai multe ferestre de cotaţii : 
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dar pentru o vizualizare uşoară vă recomandăm să deshideţi ferestrele de cotaţii din ecrane diferite. 

Fereastra de cotaţii poate avea diverse meniuri funcţie de piaţă : 

 
 
 

Meniul Chains permite afişarea tuturor constituienţilor unui indice (eg CAC40) definit pe piaţa 

respectivă. Acest meniu apare pentru pieţele care au un număr foarte mare de instrumente 

tranzacţionabile. Pentru celălalte pieţe, acest meniu este înlocuit de meniul All Quotes care permite 

afişarea tuturor instrumentelor tranzacţionabile pe bursa respectivă. 
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Meniul List vă permite definirea unei liste proprii de simboluri pe care doriţi să le urmăriţi pe piaţa 

respectivă. Lista este definită prin introducerea directă a simbolului în căsuţa din stânga semnului 

plus. Dacă valoarea introdusă la simbol nu reprezintă un intrument pe piaţa respectivă, programul 

deschide o fereastră de căutare după nume : 

 
 

Meniul Ranking afişează acţiunile din listă după caştig sau pierdere sau după valoarea 
tranzacţionată. 
 

 

5.3.2. FEREASTRA TRANZACTII  

 
Fereastra tranzacţii (Trade Ticker) este afişată de obicei in partea dreaptă a ecranului. 
Dacă fereastra nu este afişată, o puteţi afişa mergând pe meniul : File-> Horizontal/Vertical 
Ticker. Puteţi alege ca fereastra să fie afişată orizontal sau vertical. 
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Fereastra poate fi configurată pentru a arăta tranzacţiile de pe una sau mai multe pieţe la care 
aveţi acces. Pentru a selecta pieţele pentru care doriţi să vedeţi tranzacţiile faceţi click drepta 
oriunde în fereastra de tranzacţii şi alegeţi meniul Setup. Apoi alegeţi din tabul Content pieţele 
dorite: 
 

 
 
De asemenea, din acelaşi meniu puteţi alege ce coloane doriţi să conţină fereastra (din 
secţiunea Display) sau să filtraţi informaţiile afişate după anumite criterii (secţiunea Filter). 
 
 
 

5.3.3. FEREASTRA INFORMATII LEVEL2  

 
Pentru a vedea informaţii Level 2 (Order book) pentru un simbol este suficient să faceţi dublu 
click (sau să faceţi click dreapta pe simbol şi să alegeţi meniul OB) pe simbol intr-una din 
ferestrele cu Quotes (All Quotes, Chain, List) sau Trade Ticker. 
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In fereastra vedere de ansamblu (Overview) puteţi vedea de asemenea detalii de performanţă 
despre simbol (Details), ştiri legate de simbol (News), informaţii despre tranzacţii (Trades) şi 
grafice şi informaţii istorice (Hist). 
 
 
 
 
 
 

5.3.4. GRAFICE EVOLUTIE TITLURI  

 
Pentru a vedea grafice ale evoluţiei unui titlu, este necesar ca în fereastra de cotaţii să faceţi 
click dreapta pe simbolul care vă interesează şi să alegeţi un tip de grafic din meniul Charts. 
Daca simbolul care vă interesează este afişat în fereastra de tranzacţii, puteţi face click dreapta 
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pe simbolul respectiv şi apoi alegeţi din submeniul cu numele simbolului tipul de grafic care vă 
interesează. 
 

 
 
După alegerea tipului de grafic programul va deschide o fereastră cu graficul solicitat. 
Prin efectuarea de click dreapta pe fereastra graficului puteţi solicita efectuarea de diverse 
analize sau modificări ale graficului afişat. 
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5.3.5. FEREASTRA DE STIRI   

 
Se acceseaza meniul Tools/News  
Fereastra de stiri prezinta stiri din diverse surse configurabile.  Se bifeaza sursele dorite si se 
apasa butonul „OK” ca in imaginea urmatoare : 

 
 
In momentul in care se va apasa butonul OK dupa selectare, se va deschide ecranul mixed 
news : 

 
 
Fereastra de ştiri se actualizează singură pe măsură ce ştirile sunt făcute publice. 
Puteţi filtra ştirile afişate folosind listele All şi Today sau mergând pe meniul Filter. 
Meniul Surse (Sources) vă permite să alegeţi sursele de la care doriţi să vedeţi ştiri. 
Meniul Alerts vă permite să definiţi alerte în funcţie de diverse condiţii setate de 
dumneavoastră. 
Pentru a citi întreaga ştire faceţi dublu click pe ea şi se va deschide în browserul de internet. 
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5.3.6. CORELAREA ECRANELOR APLICATIEI  

 
Puteţi corela ferestrele astfel încât datele afişate într-o fereastră să se modifice în funcţie de 
simbolurile pe care se face click în altă fereastra. În acest fel, spre exemplu puteţi face ca o 
fereastră de informaţii Level 2 sau/şi o fereastră grafic să afişeze automat informaţii despre 
simbolul pe care aţi făcut click în fereastra de cotaţii sau de tranzacţii. 

Pentru a corela ferestrele între ele este necesar să faceţi click pe butonul link  din bara de 
titlu a ferestrelor de grafice, de level 2 şi de cotaţii sau tranzacţii. În cazul în care nu mai doriţi 
corelarea ferestrelor este necesar să faceţi click pe butonul unlink al fiecărei ferestre pe care 
doriţi să o decorelaţi. 
 

 
 
In exemplul de mai sus au fost corelate ferestrele Cotaţii, Tranzacţii, Grafic şi Level 2. 
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6. TRANZACTIONARE SI PORTOFOLIU  

6.1. AUTENTIFICARE  
  

Pentru a putea accesa portofoliul dumneavoastră sau pentru a putea introduce/modifica ordine 
este necesar să apăsaţi butonul trading din bara de butoane meniul Tools>Trading (sau 
Shift+Ctrl+O) : 
 

 
 
Inainte de a afisa informatii in fereastra de tranzactionare, aplicatia va solicita numele si parola 
de BRD Trading :  
  

 
 
  
  

Login – introduceti numele de utilizator de trading primit de la BRD prin e-mail  
Password - valoarea afisata de catre dispozitivul Digipass fizic/mobil (pentru instructiuni privind 
utilizarea digipass-ului va rugam sa cititi capitolul 7. Utilizare Digipass).  
  

Autentificarea dinamica 
(Digipass Mobile sau fizic) 
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ATENTIE ! Daca inchideti fereastra trading, programul va solicita din nou sa va autentificati in 
momentul in care doriti sa introduceti un ordin sau cand redeschideti fereastra de trading. 
 
 

6.2. Portofoliu  
 

Pentru a vedea portofoliul dumneavoastră este necesar să faceţi click pe butonul Portfolio din 
fereastra de trading iar din lista derulanta din partea dreapta sus să alegeţi portofoliul care vă 
interesează: 
 

 
 

Pentru ca valorile din coloana Mkt Value (valoarea de piaţă) să fie actualizate cu cele din piaţă 
este necesar ca să fiţi conectat la piaţa respectivă (meniul File->Market) şi simbolurile din 
portofoliu să fie afişate în fereastra de cotaţii. 
De asemenea, in această fereastră vedeţi banii de care dispuneţi (linia Cash RON) şi limita de 
tranzacţionare (trading power). 
 
 

6.3. Tranzactii 
 

Fereastra trades afişează informaţii legate de tranzacţiile realizate în ziua curentă sau in 
perioada selectata: 
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6.4. Ordine  
 

Fereastra ordine vă afişează informaţii cu privire la ordinele introduse: 
 

 
 

Puteţi modifica un ordin făcând click dreapta pe ordin şi alegând opţiunea modify. Se va 
deschide o fereastră care vă permite să modificaţi ordinul: 
 

 
 
Ordinele limită plasate în piaţă au status-ul: market order. Ordinele refuzate (ordine refuzate de 
piaţă) au status-ul: Refused. 
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6.5. Introducere Ordine  
 

Puteţi introduce un ordin prin una din modalităţile următoare: 
- Din fereastra cu cotaţii faceţi click dreapta pe simbolul care vă interesează şi alegeţi Buy sau 
Sell (sau faceţi click pe simbol si apăsaţi + pentru cumpărare sau – pentru vânzare 
- Din fereastra de portofoliu faceţi click dreapta pe simbolul care vă interesează şi alegeţi 
Buy/Sell asset. 
 
Fereastra de introducere ordin afişează următoarele informaţii: 
 

 
 
În campul volum veţi introduce numărul de acţiuni pe care doriţi să le vindeţi sau să le 
cumpăraţi. În câmpul price veţi introduce preţul de cumpărare/vânzare. Implicit este completat 
preţul din ask/bid din momentul în care s-a deschis fereastra.  
Dacă doriţi să introduceţi un ordinl la piaţă va trebui să faceţi click pe butonul Adv si să alegeţi 
la tipul ordinului At Market. Predefinit ordinele sunt de tip limită: 
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În câmpul portofoliu veţi completa portofoliul pe care se va aloca acest ordin. După ce aţi 
completat datele ordinului, apasaţi pe butonul Buy sau Sell. Aplicaţia va afişa un mesaj de 
confirmare: 

 
 

Dacă în urma ordinului introdus se efectuează o tranzacţie, veţi fi informat printr-o alertă 
informativă: 
 

 

Până când se efectuează o tranzacţie în urma acestui ordin, ordinul va fi disponibil în lista de 
ordine din fereastra de trading. Dacă se realizeaza o tranzacţie pe baza acestui ordin, o 
tranzacţie va apărea în lista de tranzacţii iar dacă ordinul s-a efectuat în totalitate va dispărea 
din fereastra de ordine. Ordinele executate nu mai pot fi modificate. 
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7. UTILIZARE DIGIPASS VASCO  

7.1. DISPOZITIV DP 260  

  

Pentru a va autentifica folosind Digipass-ul Vasco de tip token este necesar sa efectuati 
urmatoarele  
actiuni :  
  

- Porniti digipass-ul DP 260 apasand pe butonul sageata situat in partea dreapta jos a tastaturii 
(fig 1)  
- Introduceti codul PIN al Digipass-ului setat odata cu prima activare a acestuia (fig 2)  
- Apasati pe butonul « 1 » pentru a obtine parola de conectare la fereastra de tranzactionare 
(fig 3)  
- Introduceti in campul « parola », din fereastra de login, codul furnizat de Digipass (fig 4)  
 

                   
 
 Fig.1      Fig.2         Fig.3           Fig.4   
 
 
 

Pentru a obtine o noua parola dupa ce ati obtinut o parola va trebui sa apasati pe butonul « < »  
si apoi pe butonul « 1 »  
 

7.2. DISPOZITIV SOFTWARE  
Pentru a folosi Digipass pentru Mobil este necesar sa efectuati urmatoarele actiuni:  
1) Introduceti codul PIN (configurat la prima activare a aplicatiei)  
2) Va aparea ecranul cu parola OTP generata  
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3) Pentru a genera o noua parola, folositi butonul back (al mobilului) si accesati fereastra OTP  
 
In caz de dificultati, folositi fereastra Settings pentru a obtine datele necesare administratorilor  
Anyma   
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8. GHID DE SECURITATE  
  

8.1.  Introducere 

 
Informare 
 
Toate serviciile puse la dispoziţie de BRD trebuie utilizate doar în scopuri conforme cu legislaţia 
în vigoare. 
BRD nu îşi asumă în nici un fel responsabilitatea pentru conţinutul sau activităţile desfăşurate 
de Client cu ajutorul resurselor puse la dispoziţie de BRD. Sunt investigate incidentele în urma 
monitorizării precum şi acele sesizări care ne sunt aduse la cunoştinţă de terţe persoane cu 
privire la presupuse utilizări în scop controversat sau ilegal ale resurselor puse la dispoziţie de 
BRD. Prin urmare, clientul este singurul responsabil pentru conţinutul şi modul de utilizare a 
resurselor puse la dispoziţie de BRD şi pentru respectarea de către acestea a legislaţiei în 
vigoare. 
BRD nu poate să monitorizeze, să editeze sau să cenzureze informaţiile pe care clientul le 
primeşte / transmite către terţe persoane, chiar dacă transmiterea sau primirea acestor 
informaţii se face prin intermediul resurselor BRD dar îşi rezervă dreptul de a face acest lucru în 
măsura în care este permis de legea aplicabilă. Datorita acestui lucru, BRD nu poate fi 
responsabil, în nici o formă, pentru nici o daună sau pierdere de profit pe care clientul sau terţe 
persoane le suferă ca urmare a caracterului ofensator, înşelător, ilegal sau controversat al 
acestor transmisiuni electronice. 
BRD aduce la cunoştinta clientului, pe această cale, că accesarea oricărui material disponibil pe 
Internet, direct sau prin autentificare cu parolă, furnizarea datelor personale ale utilizatorului, 
inclusiv a numerelor de cont de bancă, număr de card bancar de orice tip, acceptul încărcării 
unor aplicaţii ce se autoinstalează, acceptul unor conexiuni automate spre terţe destinaţii pot 
aduce prejudicii materiale şi/sau morale clientului. 
 
 

8.2.  Activitati interzise 

 
Utilizarea neadecvată a resurselor sistemului 
 
Activităţile întreprinse de client, de natură a dăuna calităţilor de funcţionare ale serviciului sau 
de natură a afecta resursele BRD sunt strict interzise. Reţeaua şi serviciile BRD trebuie utilizate 
într-o manieră conformă cu scopurile vizate de acesta şi pot fi utilizate numai în scopuri legale. 
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Aceste activităţi includ, dar fără a se limita la: 

 Utilizarea serviciului în moduri care contravin legislaţiei în vigoare. Printre acestea se 
numără: 
- Accesarea serviciului sau autorizarea accesării acestuia de către o altă persoană 
- Violarea intimităţii oricărei persoane prin încercarea de a obţine, colecta, stoca sau publica 
informaţii de identificare personală, cum ar fi parolele, informaţiile despre conturi, 
numerele carţilor de credit, adresele sau alte informaţii de contact, fără ştiinţa şi 
consimţământul persoanelor respective 

 Utilizarea serviciului într-un mod care l-ar putea pune în pericol sau ar putea afecta 
utilizarea acestuia de către alte persoane. Printre acestea se numără: 
- Orice încercare de a accesa serviciul într-o maniera neautorizată, împiedicarea accesului 
altor persoane la serviciu sau autorizarea oricărei terţe părţi să acceseze sau să 
utilizeze serviciile în numele clientului (cum ar fi persoanele care nu deţin conturi sau 
comunicarea propriului nume de utilizator şi a propriei parole altor persoane) 
- Utilizarea serviciului pentru a încerca obţinerea de acces neautorizat la alte servicii, date, 
conturi sau reţele de orice natura, indiferent de mijloace 
- Utilizarea proceselor sau serviciilor automatizate de orice natură pentru a accesa sau a 
utiliza serviciul, cum ar fi programele BOT, spider sau memorarea periodică în cache a 
informaţiilor stocate de BRD 
- Intenţia de a pune în pericol sau a exploata clienţi în orice manieră sau colectarea de 
informaţii de identificare personală despre oricare client 

 Falsificarea oricărei informaţii din antetul mesajelor de poştă electronică sau reprezentarea 
denaturată a identităţii, în orice manieră 

 Reprezentarea denaturată a sursei oricărei informaţii pe care o publicaţi sau incărcaţi ori 
personificarea oricărui client sau entităţi (ca în cazul practicilor de „falsificare”) 

 
În plus: 

 BRD nu-şi asumă nici o răspundere pentru conţinutul listărilor sau mesajelor de orice fel, 
create de către client. Decizia de vizualizare a conţinutului sau de comunicare cu alte 
persoane cade în responsabilitatea clientului 

 Clientul poartă răspunderea asigurării protecţiei computerului împotriva interferenţelor, 
programelor spion sau viruşilor. Recomandăm instalarea unui program de protecţie 
antivirus pe computer şi menţinerea actualizărilor la zi 

 Se interzice distribuirea de viruşi, worms ori a oricăror alte resurse electronice cu potenţial 
distructiv 
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8.3.  Alte activitati 
 

Orice alte activitaăţi nedefinite mai sus dar considerate de BRD ca fiind prejudiciabile pentru alţi 
clienţi ai BRD sau pentru integritatea şi functionalitatea reţelei BRD în general vor fi investigate, 
iar deciziile vor fi o consecinţă a gradului în care aceste activităţi respectă sau nu prezentele 
recomandari. 
 
Clientul nu are voie să incalce sau să incerce să încalce securitatea reţelei şi a serviciilor 
furnizorului, inclusiv, fără a se limita la: 

 accesarea de date care nu sunt destinate unui asemenea client sau pătrunderea într-un 
server sau cont pe care respectivul client nu are permisiunea să le acceseze 

 încercarea de a proba, scana sau testa vulnerabilitatea unui sistem sau a unei reţele sau de 
a încălca securitatea acestuia/acesteia sau măsurile de autentificare 

 încercarea de a interfera cu, de a întrerupe sau de a face inutilizabil serviciul de către un alt 
client, gazdă sau reţea 

 contrafacerea oricărui header TCP/IP sau a oricărei părţi din informaţia cuprinsă în acesta 
odată cu declanşarea oricărei acţiuni în vederea obţinerii de servicii la care un asemenea 
utilizator nu are dreptul. 

 

9. INFORMATII SUPLIMENTARE SI CONTACT  
  
Pentru a afla informaţii suplimentare legate de utilizarea aplicaţiei vă rugăm sa accesaţi meniul 
Help. 
Pentru suport sau pentru a avea acces la date de piaţă pentru diferite burse, vă rugăm să ne 
contacaţi prin email la anyma@brd.ro sau prin telefon la: +4 021 301 4336. 
 
  
  


